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1 INTRODUCTION

1.1 CAUTIONS

CAUTION
The GPS system is operated by the government of the United States, which is solely responsible for its
accuracy and maintenance. Although the GPS 15 is a precision electronic NAVigation AID (NAVAID),
any NAVAID can be misused or misinterpreted, and therefore become unsafe. Use these products at your
own risk. To reduce the risk, carefully review and understand all aspects of these Technical Specifications
before using the GPS 15. When in actual use, carefully compare indications from the GPS to all available
navigation sources including the information from other NAVAIDs, visual sightings, charts, etc. For safety,
always resolve any discrepancies before continuing navigation.

FCC
Compliance

The GPS 15 complies with Part 15 of the FCC interference limits for Class B digital devices FOR HOME
OR OFFICE USE. These limits are designed to provide reasonable protection against harmful interference
in a residential installation, and are more stringent than “outdoor” requirements.

Operation of this device is subject to the following conditions: (1) This device may not cause harmful
interference, and (2) this device must accept any interference received, including interference that may
cause undesired operation.

This equipment generates, uses and can radiate radio frequency energy and, if not installed and used in
accordance with the instructions, may cause harmful interference to radio communications. However, there
is no guarantee that interference will not occur in a particular installation. If this equipment does cause
harmful interference to radio or television reception, which can be determined by turning the equipment off
and on, the user is encouraged to try to correct the interference by one or more of the following measures:

•  Reorient or relocate the receiving antenna.

•  Increase the separation between the equipment and receiver.

•  Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

•  Consult the dealer or an experienced radio/TV technician for help.

The GPS 15 does not contain any user-serviceable parts. Unauthorized repairs or modifications could result
in permanent damage to the equipment, and void your warranty and your authority to operate this device
under Part 15 regulations.
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1.2 LIMITED WARRANTY
This Garmin product is warranted to be free from defects in materials or workmanship for one year from
the date of purchase. Within this period, Garmin will at its sole option, repair or replace any components
that fail in normal use. Such repairs or replacement will be made at no charge to the customer for parts or
labor, provided that the customer shall be responsible for any transportation cost. This warranty does not
cover failures due to abuse, misuse, accident, or unauthorized alteration or repairs.

THE WARRANTIES AND REMEDIES CONTAINED HEREIN ARE EXCLUSIVE AND IN LIEU OF
ALL OTHER WARRANTIES EXPRESS OR IMPLIED OR STATUTORY, INCLUDING ANY
LIABILITY ARISING UNDER ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A
PARTICULAR PURPOSE, STATUTORY OR OTHERWISE. THIS WARRANTY GIVES YOU
SPECIFIC LEGAL RIGHTS, WHICH MAY VARY FROM STATE TO STATE.

IN NO EVENT SHALL GARMIN BE LIABLE FOR ANY INCIDENTAL, SPECIAL, INDIRECT, OR
CONSEQUENTIAL DAMAGES, WHETHER RESULTING FROM THE USE, MISUSE, OR
INABILITY TO USE THIS PRODUCT OR FROM DEFECTS IN THE PRODUCT. Some states do not
allow the exclusion of incidental or consequential damages, so the above limitations may not apply to you.

Garmin retains the exclusive right to repair or replace the unit or software or offer a full refund of the
purchase price at its sole discretion. SUCH REMEDY SHALL BE YOUR SOLE AND EXCLUSIVE
REMEDY FOR ANY BREACH OF WARRANTY.

To obtain warranty service, contact your local Garmin authorized dealer. Or call Garmin Customer Service
at one of the numbers shown below, for shipping instructions and an RMA tracking number. The unit
should be securely packed with the tracking number clearly written on the outside of the package. The unit
should then be sent, freight charges prepaid, to any Garmin warranty service station. A copy of the original
sales receipt is required as the proof of purchase for warranty repairs.

Garmin International, Inc.
1200 East 151st Street
Olathe, KS  66062 U.S.A.
Telephone: 913/397.8200
FAX: 913/397.8282

Garmin (Europe) Ltd.
Unit 5, The Quadrangle, Abbey Park Industrial Estate
Romsey SO51 9DL, U.K.
Telephone: 44/1794.519944
FAX: 44/1794.519222
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1.3 OVERVIEW
The GPS 15 is part of Garmin’s latest generation of GPS sensor boards designed for a broad spectrum of
OEM (Original Equipment Manufacture) system applications. Based on the proven technology found in
other Garmin 12-channel GPS receivers, the GPS 15 tracks up to 12 satellites at a time while providing fast
time-to-first-fix, one-second navigation updates, and low power consumption. The far-reaching capabilities
of the GPS 15 meet the sensitivity requirements of land navigation as well as the dynamics requirements of
high-performance aircraft.

The GPS 15 design utilizes the latest technology and high-level circuit integration to achieve superior
performance while minimizing space and power requirements. All critical components of the system
including the RF/IF receiver hardware and the digital baseband are designed and manufactured by Garmin
to ensure the quality and capability of the GPS. The hardware capability combined with software
intelligence makes the GPS 15 easy to integrate and use.

Being a complete GPS receiver, the GPS 15 requires minimal additional components to be supplied by an
OEM or system integrator. A minimum system must provide the GPS with a source of power, an active
GPS antenna, and a clear view of the GPS satellites. The system may communicate with the GPS 15 via its
3.3V CMOS-level serial port. The GPS 15 stores data such as satellite orbital parameters, last-known
position, and date and time in battery backed up SRAM. End-user interfaces, such as keyboards and
displays, are the responsibility of the application designer.

1.4 FEATURES
•  12-channel GPS receiver tracks and uses up to 12 satellites for fast, accurate positioning and low

power consumption.

•  Compact, rugged design ideal for applications with minimal space.

•  May be remotely mounted in an out-of-the-way location.

•  User initialization is not required. Once installed, unit automatically produces navigation data.

•  On-board backup battery to maintain the non-volatile SRAM and real-time clock for up to 21 days.

•  Provision for external power to maintain the charge on the backup battery.

•  Configurable parameters include expected position, current time and date, preferred position fix type
(2D, 3D, or automatic), and velocity filter time constant (none, automatic, or your choice between 2
and 255 seconds).
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1.5 TECHNICAL SPECIFICATIONS
Specifications are subject to change without notice.

1.5.1 Physical Characteristics

1.5.1.1 Size
0.940” (23.88 mm) wide x 1.690” (42.93 mm) long x 0.309” (7.84 mm) high

1.5.1.2 Weight
0.35 oz. (10 g)

1.5.1.3 Available Connector Options
GPS 15-F: 6-pin LIF (Low Insertion Force) flex connector, 1 millimeter pitch. For use with common

1mm pitch, 6-conductor flex cable, available as Garmin Part Number 310-00040-00. This
flex cable mates with common 1mm pitch, 6-pin flex connector, such as Garmin Part
Number 330-00346-06 or Molex Part Number 52793-0690. Refer to the Molex web site
at www.molex.com.

GPS 15-W: 6-pin JST connector, 1 millimeter pitch; mating wire harness included. (Garmin Part
Number 325-00118-00). The connector housing used on this harness is equivalent to JST
Part Number SHR-06V-S-B. The 6-wire crimp socket is equivalent to JST Part Number
SSH-003T-P0.2. Refer the JST web site at www.jst.com.

1.5.1.4 Antenna Connector
The GPS 15 provides a MCX female connector for connection to an active GPS antenna. The antenna
should be terminated in MCX male. A suitable antenna is Garmin’s GA 27C Antenna (Garmin Part
Number 010-10052-05). Other antennas that are terminated in male BNC connectors may be adapted via a
Garmin MCX to BNC Adapter Cable is used (Garmin Part Number 010-10121-00).

1.5.2 Electrical Characteristics

1.5.2.1 Input Voltage
3.3 Vdc regulated, ±50mV ripple

1.5.2.2 Input Current
75mA peak, 66mA nominal

1.5.2.3 CMOS Serial Output Levels
0V to 3.3V (Asynchronous Serial, UART Compatible Polarity)

1.5.2.4 GPS Receiver Sensitivity
-165 dBW minimum

1.5.3 Environmental Characteristics
•  Operating Temperature: -30°C to +80°C

•  Storage Temperature: -40°C to +90°C

http://www.molex.com/
www.jst.com
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1.5.4 GPS Performance

1.5.4.1 Receiver
12 parallel channel GPS receiver continuously tracks and uses up to 12 satellites to compute and update
your position.

1.5.4.2 Acquisition Times
•  Reacquisition: Less than 2 seconds

•  Warm: Approx. 15 seconds (all data known)

•  Cold: Approx. 45 seconds (initial position, time, and almanac known; ephemeris unknown)

•  AutoLocateTM: 5 minutes (almanac known; initial position and time unknown)

•  SkySearch: 5 minutes (no data known)

1.5.4.3 Update Rate
1 record per second

1.5.4.4 Accuracy
•  GPS Standard Positioning Service (SPS)

Position: < 15 meters, 95% typical
Velocity: 0.1 knot RMS steady state

•  Dynamics: 999 knots velocity (only limited at altitude greater than 60,000 feet),
6g acceleration, <6g jerk

1.5.5 Interfaces

1.5.5.1 GPS 15 Electrical Characteristics
•  CMOS level output for interfacing directly to an asynchronous serial port on the host microprocessor.

•  Factory jumper settings determine baud rate (not user-accessible). Factory setting is 4800 baud.

1.5.5.2 Port 1 Protocols
•  NMEA 0183 Version 2.20

•  ASCII output sentences GPGGA, GPGSA, GPGSV, and GPRMC (NMEA-approved sentences);
PGRME, PGRMM, and PGRMT (Garmin proprietary sentences)

•  NMEA 0183 Outputs (see Section 4.2 Transmitted NMEA 0183 Sentences for full protocol
specifications)
Position, velocity, and time
Receiver and satellite status
Geometry and error estimates

•  NMEA 0183 Inputs (see Section 4.1 Received NMEA 0183 Sentences for full protocol specifications)
Initialize position, date, and time (not required)
Initialize Earth datum
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1.5.6 Antenna Specifications
Should be an active antenna with the following specifications:
Gain: Antenna should provide between 10 dB to 40 dB net gain between the

antenna feed point and the connection to the GPS15. All amplifier gains,
filter losses, cable losses, etc. must be considered when calculating the
gain.

RF Connection: GPS 15 RF Connection: MCX Female connector (on the GPS 15 board)
Antenna Connection: MCX Male connector (on the end of the antenna
cable)

Garmin Antenna: GPS 27C (Garmin Part Number 010-10052-05) provides the required
MCX Male connector. Other Garmin antennas terminated in a BNC Male
connector may also be used if a Garmin MCX to BNC Adapter Cable
(Garmin Part Number 010-10121-00) is used. Place the MCX to BNC
Adapter Cable between the connector on the end of the antenna cable and
the connector on the GPS 15.

Noise Figure/Gain: The total noise on the external antenna must be ≤ 7dB with a gain between
10 dB and 40 dB.  Refer to the table below.

Table 1: Gain vs. SNR for Given Noise Figure

Should be properly biased by your choice of:
Power from on-board source: 3.3 Vdc, the voltage you supply to Vin, through an on-board  ~10 Ohm

current limiting resistance. The antenna must not draw more than 60mA.
Power from external source: 4.0 to 8.0 Vdc bias through the series combination of an on-board ~10

Ohm current limiting resistance and a Schottky diode. The antenna must
not draw more than 60mA.
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14.0
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2 GPS 15 WIRE DESCRIPTIONS AND WIRING DIAGRAMS

The GPS 15-F uses a six-contact flex circuit LIF (low insertion force) connector. The GPS 15-W uses a six-
pin JST connector (mating wire harness included). (See Section 1.5.1.3 for details.)

2.1 GPS 15 WIRE DESCRIPTIONS
GPS
15

Pin #
Signal Name Description

1 BACKUP POWER This input provides external power to maintain the battery-backed
SRAM and real-time clock. This enables the user to provide backup
power if needed for longer than the on-board rechargeable battery
will provide (roughly 21 days). Input voltage must be between +2.8
and +3.4 Vdc.

2 GROUND Power and Signal Ground
3 POWER Regulated +3.3 Vdc input. Peak operating current is 75mA. Nominal

operating current is 66mA.
4 PORT 1 DATA OUT Asynchronous Serial Output.

CMOS compatible output designed to interface directly with a host
microprocessor. Provides serial data which is formatted per “NMEA
0183, Version 2.20”. The baud rate is set during production to 4800,
but other rates are available.

5 PORT 1 DATA IN First Asynchronous Serial Input.
CMOS compatible input designed to interface directly with a host
microprocessor. Input voltage range of 0 < V < 3.3.

6 RF BIAS This input allows the user to externally apply an RF bias to the active
antenna. By default, the unit will use an internal voltage to power the
active antenna. If an external voltage greater than the internal voltage
of the center pin of the antenna (between 4.0 V and 8.0 V) is
detected at this input, the GPS 15 will automatically changes to the
external voltage. The antenna must not draw more than 60mA.
Table 2: GPS 15 Wire Descriptions
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2.2 GPS 15 WIRING DIAGRAMS

Figure 1: Computer Serial Port Interconnection

Figure 2: PDA Serial Port Interconnection

Figure 3: Basic NMEA Device Interconnection
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3 MECHANICAL CHARACTERISTICS & MOUNTING

Figure 4: GPS 15-F Dimensions

Figure 5: GPS 15-W Outline Drawing
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4 GPS 15 SOFTWARE INTERFACE

The GPS 15 interface protocol design on COM 1 is based on the National Marine Electronics Association’s
NMEA 0183 ASCII interface specification. This standard is fully defined in NMEA 0183, Version 2.20.
Copies may be obtained from NMEA, www.nmea.org.

The GPS 15 interface protocol, in addition to transmitting navigation information as defined by NMEA
0183, transmits additional information using the convention of Garmin proprietary sentences. These
proprietary sentences begin with the characters, “$PGRM”, instead of the characters “$G” that are typical
of the standard NMEA 0183 sentences. The characters “$P” indicate that the sentence is a proprietary
implementation and the characters and “GRM” indicate that it is Garmin’s proprietary sentence. The letter
(or letters) that follow the characters “$PGRM” uniquely identifies that particular Garmin proprietary
sentence.

The following sections describe the NMEA 0183 data format of each sentence transmitted and received by
the GPS 15.

4.1 RECEIVED NMEA 0183 SENTENCES
The following paragraphs define the sentences that can be received on the GPS sensors’ port. Null fields in
the configuration sentence indicate no change in the particular configuration parameter. All sentences
received by the GPS sensor must be terminated with <CR><LF>, the ASCII characters for carriage return
(0D hexadecimal) and line feed (0A hexadecimal), respectively. The checksum *hh is used for parity
checking data and is not required, but is recommended for use in environments containing high
electromagnetic noise. It is generally not required in normal PC environments. When used, the parity bytes
(hh) are the ASCII representation of the upper and lower nibbles of the exclusive-or (XOR) sum of all the
characters between the “$” and “*” characters, non-inclusive. The hex representation must be a capital
letter, such as 3D instead of 3d. Sentences may be truncated by <CR><LF> after any data field and valid
fields up to that point will be acted on by the sensor.

4.1.1 Sensor Initialization Information (PGRMI)
The $PGRMI sentence provides information used to initialize the GPS sensor’s set position and time used
for satellite acquisition. Receipt of this sentence by the GPS sensor causes the software to restart the
satellite acquisition process. If there are no errors in the sentence, it will be echoed upon receipt. If an error
is detected, the echoed PGRMI sentence will contain the current default values. Current PGRMI defaults
(with the exception of the Receiver Command, which is a command rather than a mode) can also be
obtained by sending $PGRMIE to the GPS sensor.

$PGRMI,<1>,<2>,<3>,<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Latitude, ddmm.mmm format (leading zeros must be transmitted)
<2> Latitude hemisphere, N or S
<3> Longitude, dddmm.mmm format (leading zeros must be transmitted)
<4> Longitude hemisphere, E or W
<5> Current UTC date, ddmmyy format
<6> Current UTC time, hhmmss format
<7> Receiver Command, A = Auto Locate, R = Unit Reset

http://www.nmea.org)/
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4.1.2 Sensor Configuration Information (PGRMC)
The $PGRMC sentence provides information used to configure the GPS sensor’s operation. Configuration
parameters are stored in non-volatile memory and retained between power cycles. The GPS sensor will
echo this sentence upon its receipt if no errors are detected. If an error is detected, the echoed PGRMC
sentence will contain the current default values. Current default values can also be obtained by sending
$PGRMCE to the GPS sensor.

$PGRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>,<13>,<14>*hh<CR><LF>

<1> Fix mode, A = automatic, 2 = 2D exclusively (host system must supply altitude),
3 = 3D exclusively

<2> Altitude above/below mean sea level, -1500.0 to 18000.0 meters
<3> Earth datum index. If the user datum index (96) is specified, fields <4> through <8> must

contain valid values. Otherwise, fields <4> through <8> must be null. Refer to Appendix A:
Earth Datums for a list of earth datums and the corresponding earth datum index.

<4> User earth datum semi-major axis, 6360000.000 to 6380000.000 meters (.001 meters
resolution)

<5> User earth datum inverse flattening factor, 285.0 to 310.0 (10-9 resolution)
<6> User earth datum delta x earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)
<7> User earth datum delta y earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)
<8> User earth datum delta z earth centered coordinate, -5000.0 to 5000.0 meters (1 meter

resolution)
<9> Not Used.

<10> Not Used.
<11> Velocity filter, 0 = No filter, 1 = Automatic filter, 2-255 = Filter time constant (e.g., 10 = 10

second filter)
<12> Not Used.
<13> Not Used.
<14> Dead reckoning valid time 1-30 (sec)

All configuration changes take effect after receipt of a valid value except baud rate and PPS mode. Baud
rate and PPS mode changes take effect on the next power cycle or an external reset event.

4.1.3 Miscellaneous Commands (PGRMO)
The $PGRMO sentence provides the ability to change between normal and power save modes, as well as
select Garmin data format for the remainder of the power cycle.

$PGRMO,<1>,<2>*hh<CR><LF>

<1> Not used.
<2> Command, where:

B = change to power save mode
G = change to Garmin proprietary data format for the remainder of the power cycle.
N = change to normal (as opposed to power save) mode.
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4.2 TRANSMITTED NMEA 0183 SENTENCES
The subsequent paragraphs define the sentences that can be transmitted on COM 1 by the GPS sensor.

4.2.1 Sentence Transmission
The GPS sensor will transmit each sentence (except where noted in particular transmitted sentence
descriptions) at a one-second rate. The GPS sensor will transmit the following sentences contiguously. The
contiguous transmission starts at a GPS second boundary. The information transmitted by the GPS sensor is
referenced to the GPS second boundary immediately preceding the GPRMC sentence. The following
sentences are all output by default.

Sentence
GPRMC
GPGGA
GPGSA
GPGSV
PGRME

PGRMT (output once per minute by default)
PGRMM

Table 3: NMEA 0183 Output Sentence Order

The maximum number of fields allowed in a single sentence is 82 characters including delimiters. Values
in the table include the sentence start delimiter character “$” and the termination delimiter <CR><LF>. The
factory set defaults will result in a once-per-second transmission at the NMEA 0183 specification
transmission rate of 4800 baud.
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4.2.2 Transmitted Time
The GPS sensor outputs UTC (Coordinated Universal Time) date and time of day in the transmitted
sentences. Before the initial position fix, the on-board clock provides the date and time of day. After the
initial position fix, the date and time of day are calculated using GPS satellite information and are
synchronized with the one-pulse-per-second output.

The GPS sensor uses information obtained from the GPS satellites to add or delete UTC leap seconds and
correct the transmitted date and time of day. The transmitted date and time of day for leap second
correction follow the guidelines in “National Institute of Standards and Technology Special Publication
432 (Revised 1990)” (for sale by the Superintendent of Documents, U.S. Government Printing Office,
Washington, D.C., 20402, U.S.A.).

When a positive leap second is required, one second is inserted at the beginning of the first hour (0h 0m 0s)
of the day that the positive leap is occurring. The minute containing the leap second is 61 seconds long. The
GPS sensor would have transmitted this information for the leap second added December 31, 1998 as
follows:

$GPRMC,235959,A,3851.3651,N,09447.9382,W,000.0,221.9,071103,003.3,E*69

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67

$GPRMC,000000,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*67

$GPRMC,000001,A,3851.3651,N,09447.9382,W,000.0,221.9,081103,003.3,E*66

If a negative leap second should be required, one second will be deleted at the end of some UTC month.
The minute containing the leap second will be only 59 seconds long. In this case, the GPS sensor will not
transmit the time of day 0h 0m 0s (the “zero” second) for the day from which the leap second is removed.

$GPRMC,235959,A,3851.3650,N,09447.9373,W,000.0,000.0,111103,003.3,E*69

$GPRMC,000001,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*6A

$GPRMC,000002,A,3851.3650,N,09447.9373,W,000.0,000.0,121103,003.3,E*69

4.2.3 Global Positioning System Fix Data (GGA)
$GPGGA,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,M,<10>,M,<11>,<12>*hh<CR><LF>

<1> UTC time of position fix, hhmmss format
<2> Latitude, ddmm.mmmm format (leading zeros will be transmitted)
<3> Latitude hemisphere, N or S
<4> Longitude, dddmm.mmmm format (leading zeros will be transmitted)
<5> Longitude hemisphere, E or W
<6> GPS quality indication, 0 = fix not available, 1 = Non-differential GPS fix available,
<7> Number of satellites in use, 00 to 12 (leading zeros will be transmitted)
<8> Horizontal dilution of precision, 0.5 to 99.9
<9> Antenna height above/below mean sea level, -9999.9 to 99999.9 meters

<10> Geoidal height, -999.9 to 9999.9 meters
<11> Not Used.
<12> Not Used.
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4.2.4 GPS DOP and Active Satellites (GSA)
$GPGSA,<1>,<2>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<3>,<4>,<5>,<6>*hh<CR><LF>

<1> Mode, M = manual, A = automatic
<2> Fix type, 1 = not available, 2 = 2D, 3 = 3D
<3> PRN number, 01 to 32, of satellite used in solution, up to 12 transmitted (leading zeros will be

transmitted)
<4> Position dilution of precision, 0.5 to 99.9
<5> Horizontal dilution of precision, 0.5 to 99.9
<6> Vertical dilution of precision, 0.5 to 99.9

4.2.5 GPS Satellites in View (GSV)
$GPGSV,<1>,<2>,<3>,<4>,<5>,<6>,<7>,...<4>,<5>,<6>,<7>*hh<CR><LF>

<1> Total number of GSV sentences to be transmitted
<2> Number of current GSV sentence
<3> Total number of satellites in view, 00 to 12 (leading zeros will be transmitted)
<4> Satellite PRN number, 01 to 32 (leading zeros will be transmitted)
<5> Satellite elevation, 00 to 90 degrees (leading zeros will be transmitted)
<6> Satellite azimuth, 000 to 359 degrees, true (leading zeros will be transmitted)
<7> Signal to noise ratio (C/No) 00 to 99 dB, null when not tracking (leading zeros will be

transmitted)
NOTE:  Items <4>,<5>,<6>, and <7> repeat for each satellite in view to a maximum of four (4) satellites
per sentence. Additional satellites in view information must be sent in subsequent bursts of NMEA 0183
data. These fields will be null if unused.

4.2.6 Recommended Minimum Specific GPS/TRANSIT Data (RMC)
$GPRMC,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>,<10>,<11>,<12>*hh<CR><LF>

<1> UTC time of position fix, hhmmss format
<2> Status, A = Valid position, V = NAV receiver warning
<3> Latitude, ddmm.mmmm format (leading zeros will be transmitted)
<4> Latitude hemisphere, N or S
<5> Longitude, dddmm.mmmm format (leading zeros will be transmitted)
<6> Longitude hemisphere, E or W
<7> Speed over ground, 000.0 to 999.9 knots (leading zeros will be transmitted)
<8> Course over ground, 000.0 to 359.9 degrees, true (leading zeros will be transmitted)
<9> UTC date of position fix, ddmmyy format

<10> Magnetic variation, 000.0 to 180.0 degrees (leading zeros will be transmitted)
<11> Magnetic variation direction, E or W (westerly variation adds to true course)

4.2.7 Estimated Error Information (PGRME)
$PGRME,<1>,M,<2>,M,<3>,M*hh<CR><LF>

<1> Estimated horizontal position error (HPE), 0.0 to 999.9 meters
<2> Estimated vertical position error (VPE), 0.0 to 999.9 meters
<3> Estimated position error (EPE), 0.0 to 999.9 meters

4.2.8 Map Datum (PGRMM)
The Garmin Proprietary sentence $PGRMM gives the name of the map datum currently in use by the GPS
sensor. This information is used by the Garmin MapSource real-time plotting application.

$PGRMM,<1>*hh<CR><LF>

<1> Name of map datum currently in use (variable length field, e.g., “WGS 84”)
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4.2.9 Sensor Status Information (PGRMT)
The GARMIN Proprietary sentence $PGRMT gives information concerning the status of the GPS sensor.
This sentence is transmitted once per minute regardless of the selected baud rate.

$PGRMT,<1>,<2>,<3>,<4>,<5>,<6>,<7>,<8>,<9>*hh<CR><LF>

<1> Product, model and software version (variable length field, e.g., “GPS 15 VER  2.05”)
<2> ROM checksum test, P = pass, F = fail
<3> Receiver failure discrete, P = pass, F = fail
<4> Stored data lost, R = retained, L = lost
<5> Real time clock lost, R = retained, L = lost
<6> Oscillator drift discrete, P = pass, F = excessive drift detected
<7> Data collection discrete, C = collecting, null if not collecting
<8> GPS sensor temperature in degrees C
<9> Not used.
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APPENDIX A: EARTH DATUMS

The following is a list of the Garmin GPS 15 Earth datum indices and the corresponding earth datum name
(including the area of application):

0 ADINDAN - Ethiopia, Mali, Senegal, Sudan

1 AFGOOYE - Somalia

2 AIN EL ABD 1970 - Bahrain Island, Saudi Arabia

3 ANNA 1 ASTRO 1965 - Cocos Island

4 ARC 1950 - Botswana, Lesotho, Malawi, Swaziland, Zaire, Zambia, Zimbabwe

5 ARC 1960 - Kenya, Tanzania

6 ASCENSION ISLAND 1958 - Ascension Island

7 ASTRO BEACON “E” - Iwo Jima Island

8 AUSTRALIAN GEODETIC 1966 - Australia, Tasmania Island

9 AUSTRALIAN GEODETIC 1984 - Australia, Tasmania Island

10 ASTRO DOS 71/4 - St. Helena Island

11 ASTRONOMIC STATION 1952 - Marcus Island

12 ASTRO B4 SOROL ATOLL - Tern Island

13 BELLEVUE (IGN) - Efate and Erromango Islands

14 BERMUDA 1957 - Bermuda Islands

15 BOGOTA OBSERVATORY - Colombia

16 CAMPO INCHAUSPE - Argentina

17 CANTON ASTRO 1966 - Phoenix Islands

15 CAPE CANAVERAL - Florida, Bahama Islands

19 CAPE - South Africa

20 CARTHAGE - Tunisia

21 CHATHAM 1971 - Chatham Island (New Zealand)

22 CHUA ASTRO - Paraguay

23 CORREGO ALEGRE - Brazil

24 DJAKARTA (BATAVIA) - Sumatra Island (Indonesia)

25 DOS 1968 - Gizo Island (New Georgia Islands)

26 EASTER ISLAND 1967 - Easter Island

27 EUROPEAN 1950 - Austria, Belgium, Denmark, Finland, France, Germany, Gibraltar, Greece,
Italy, Luxembourg, Netherlands, Norway, Portugal, Spain, Sweden, Switzerland

28 EUROPEAN 1979 - Austria, Finland, Netherlands, Norway, Spain, Sweden, Switzerland

29 FINLAND HAYFORD 1910 - Finland

30 GANDAJIKA BASE - Republic of Maldives

31 GEODETIC DATUM 1949 - New Zealand

32 ORDNANCE SURVEY OF GREAT BRITAIN 1936 - England, Isle of Man, Scotland,
Shetland Islands, Wales

33 GUAM 1963 - Guam Island

34 GUX 1 ASTRO - Guadalcanal Island
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35 HJORSEY 1955 - Iceland

36 HONG KONG 1963 - Hong Kong

37 INDIAN - Bangladesh, India, Nepal

38 INDIAN - Thailand, Vietnam

39 IRELAND 1965 - Ireland

40 ISTS O73 ASTRO 1969 - Diego Garcia

41 JOHNSTON ISLAND 1961 - Johnston Island

42 KANDAWALA - Sri Lanka

43 KERGUELEN ISLAND - Kerguelen Island

44 KERTAU 1948 - West Malaysia, Singapore

45 L.C. 5 ASTRO - Cayman Brac Island

46 LIBERIA 1964 - Liberia

47 LUZON - Mindanao Island

48 LUZON - Phillippines (excluding Mindanao Island)

49 MAHE 1971 - Mahe Island

50 MARCO ASTRO - Salvage Islands

51 MASSAWA - Eritrea (Ethiopia)

52 MERCHICH - Morocco

53 MIDWAY ASTRO 1961 - Midway Island

54 MINNA - Nigeria

55 NORTH AMERICAN 1927 - Alaska

56 NORTH AMERICAN 1927 - Bahamas (excluding San Salvador Island)

57 NORTH AMERICAN 1927 - Central America (Belize, Costa Rica, El Salvador, Guatemala,
Honduras, Nicaragua)

58 NORTH AMERICAN 1927 - Canal Zone

59 NORTH AMERICAN 1927 - Canada (including Newfoundland Island)

60 NORTH AMERICAN 1927 - Caribbean (Barbados, Caicos Islands, Cuba, Dominican
Republic, Grand Cayman, Jamaica, Leeward Islands, Turks Islands)

61 NORTH AMERICAN 1927 - Mean Value (CONUS)

62 NORTH AMERICAN 1927 - Cuba

63 NORTH AMERICAN 1927 - Greenland (Hayes Peninsula)

64 NORTH AMERICAN 1927 - Mexico

65 NORTH AMERICAN 1927 - San Salvador Island

66 NORTH AMERICAN 1983 - Alaska, Canada, Central America, CONUS, Mexico

67 NAPARIMA, BWI - Trinidad and Tobago

68 NAHRWAN - Masirah Island (Oman)

69 NAHRWAN - Saudi Arabia

70 NAHRWAN - United Arab Emirates

71 OBSERVATORIO 1966 - Corvo and Flores Islands (Azores)

72 OLD EGYPTIAN - Egypt

73 OLD HAWAIIAN - Mean Value
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74 OMAN - Oman

75 PICO DE LAS NIEVES - Canary Islands

76 PITCAIRN ASTRO 1967 - Pitcairn Island

77 PUERTO RICO - Puerto Rico, Virgin Islands

78 QATAR NATIONAL - Qatar

79 QORNOQ - South Greenland

80 REUNION - Mascarene Island

81 ROME 1940 - Sardinia Island

82 RT 90 - Sweden

83 PROVISIONAL SOUTH AMERICAN 1956 - Bolivia, Chile, Colombia, Ecuador, Guyana,
Peru, Venezuela

84 SOUTH AMERICAN 1969 - Argentina, Bolivia, Brazil, Chile, Colombia, Ecuador, Guyana,
Paraguay, Peru, Venezuela, Trinidad and Tobago

85 SOUTH ASIA - Singapore

86 PROVISIONAL SOUTH CHILEAN 1963 - South Chile

87 SANTO (DOS) - Espirito Santo Island

88 SAO BRAZ - Sao Miguel, Santa Maria Islands (Azores)

89 SAPPER HILL 1943 - East Falkland Island

90 SCHWARZECK - Namibia

91 SOUTHEAST BASE - Porto Santo and Madeira Islands

92 SOUTHWEST BASE - Faial, Graciosa, Pico, Sao Jorge, and Terceira Islands (Azores)

93 TIMBALAI 1948 - Brunei and East Malaysia (Sarawak and Sabah)

94 TOKYO - Japan, Korea, Okinawa

95 TRISTAN ASTRO 1968 - Tristan da Cunha

96 User defined earth datum

97 VITI LEVU 1916 - Viti Levu Island (Fiji Islands)

98 WAKE-ENIWETOK 1960 - Marshall Islands

99 WORLD GEODETIC SYSTEM 1972

100 WORLD GEODETIC SYSTEM 1984

101 ZANDERIJ - Surinam

102 CH-1903 - Switzerland

103 Hu - Tzu - Shan

104 Indonesia 74

105 Austria

106 Potsdam

107 Taiwan - modified Hu-Tzu-Shan

108 GDA - Geocentric Datum of Australia

109 Dutch
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APPENDIX B: SENSOR CONFIGURATION SOFTWARE

SNSRCFG configures the GPS sensors based on user-selected parameters. Some application features
include the ability to download GPS sensor configuration, maintain different configurations in files, and
perform GPS sensor configurations quickly with the use of one function key.

This section provides a brief overview of the Sensor Configuration Software. Refer to this section when
using the software to configure your Garmin sensor.

Downloading the Sensor Configuration Software
The Garmin Sensor Configuration Software (SNSRCFG.exe) is
available from the Garmin Web site. To download the software,
start at http://www.garmin.com/oem, select the GPS 15H / GPS
15L, and then select Software Updates. The Garmin Sensor
Configuration Software (SNSRCFG.exe) is included in the
software update download. Delete or ignore the other files
included in the download as they will only pertain to the GPS 15L
and GPS 15H.

Selecting a Model
After opening the program (snsrcfg.exe), the following screen
appears. Select the radio button next to the type of Garmin sensor
you are configuring.

Connecting to the Sensor
After selecting the type of sensor, the following window opens. This is
the Main Interface Screen for the program.

To configure your sensor, you must first connect to the sensor.

1. Select Config > Switch to NMEA Mode (or press the F10 key).

2. Select Comm > Setup to open the
Comm Setup Window.

3. Select the Serial Port to which the
sensor is connected. Select Auto to
have the program automatically
determine the Baud Rate, or select
Manual to manually select the
Baud Rate of the GPS 15. Click
OK when done.

4. Click the Connect icon , or
select Comm > Connect.

5. To view the current programming
of the sensor, select Config > Get
Configuration from GPS (or
press the F8 key). The current
programming of the sensor is
displayed in the window shown to
the right.

File Menu
The File Menu allows you to open,
save, and print sensor configurations.
The items in the File Menu work like
most Windows-based programs.

http://www.garmin.com/oem


GPS 15 Technical Specifications (P/N 190-00266-00) Rev. B
Page 20

Comm Menu
The Comm (Communication) Menu allows you to set the port number, baud rate, and then connect and
disconnect from the sensor.

Setup: Opens the Comm Setup Window, shown to the left. Select
the Serial Port to which the sensor is connected from the drop-
down list. Then select Auto (the program determines the baud rate
on its own) or Manual (you then enter the baud rate) for the Baud
Rate entry.

Connect: Select Connect to connect to the sensor to change or
view the configuration.

Disconnect: Select Disconnect to disconnect from the sensor.

Config Menu
The Config (Configuration) Menu allows you
configure the sensor as it is connected.

Sensor Configuration (F6): Opens the Sensor
Configuration Window, shown to the right. Many
of the fields in this window should be left alone.
Please refer to the beginning of this manual for
clarification about some of these fields. For the
most part, this window is used to enter a new
Latitude, Longitude, and Altitude for the sensor.
This is especially helpful when you are
programming the sensor for use in a particular
geographic location.

Resetting the Unit (Reset Unit) performs a reset
on the unit, much like cycling the power.

Resetting the non-volatile memory (Reset
NonVol) will clear all of the data from the non-
volatile memory.

NMEA Sentence Selections (F7): Displays the
NMEA Sentence Selections Window. If the
sentence is enabled, a check mark appears in the
box to the left of the sentence name. Click the box
to enable or disable to the sentence.
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Get Configuration From GPS (F8): Retrieves the current programming from the sensor. The
programming is then displayed in the Main Interface Window.

Send Configuration To GPS (F9): Sends the changes you have made to the programming to the sensor.

Switch to NMEA Mode (F10): Switches the unit to NMEA Mode. The sensor must be in NMEA Mode in
order to establish a serial connection to this software (see “Connecting to the Sensor” above).

Switch to Garmin Mode (F11): Switches the unit to Garmin Mode.

Update Software (F12): Not applicable for the GPS 15. After you have downloaded a new software
version for the sensor, you can update the sensor with the new software. Select Update Software and then
select the file using the Open dialog box. You must locate both the *.rgn file and the updater.exe file.

View Menu
The View Menu allows you to view the NMEA sentences transmitted by the sensor. You can also
customize how the program looks by showing and hiding the Toolbar and Status Bar.

Help Menu
The Help Menu displays the software version and copyright information.



For the latest free software updates (excluding map data) throughout the life of your
Garmin products, visit the Garmin Web site at www.garmin.com.
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